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General Information 
 

Welcome 
 

Welcome to the Scia Engineer 15 AISC Steel Frame Tutorial. Scia Engineer is a design program in Windows with a broad application 

field: from checking/designing simple frames to the advanced design of complex projects in steel, concrete, cold formed steel  and a 
variety of other materials. 

The software allows engineers to model 2D and 3D structures which include flat or curved plates and beam members (straight or curved) 

as well as other advanced 3D geometry.  The complete calculation and design process has been integrated into one program so that the 
input of geometry, input of calculation information (loads, combinations, and supports), linear and non-linear calculation, output of results, 
reinforcement design according to various codes and the generation of the calculation documentation are all c ompleted in the same 

software. 

Scia Engineer is available in three different editions all which require a license to operate: 

- Concept 

- Professional 

- Expert 

License version  

A licensed version of Scia Engineer is secured with either a ódongleô, which you apply to the USB port of your computer or a software 

license on your companyôs network. 

Scia Engineer is also modular and consists of various modules. The user chooses from the available modules and composes a cus tom 

design program, perfectly tuned to the desired needs of the company. 

In the general product overview of Scia Engineer you will find an overview of the different modules that are available.  

 

Demo version  

If the program doesnôt find a license on your computer, it will automatically start the demo version. The properties of the demo version 

are: 

- All projects can be inserted however projects created in a demo version cannot be opened in a licensed version. 

- The calculation is restricted to projects with 25 elements, 3 plates/shells and two load cases 

- The output contains a watermark ñUnlicensed softwareò 

Scia Engineer Support 
If you need assistance with the software, you can contact the Scia Engineer support service in the following manners:  

By e-mail 

Send an e-mail to support@scia.net with a description of the problem and the concerning *.esa file, and mention the number of the 

version you are currently working with. 

By telephone 

 From USA: 443-542-0637 

Via the Scia Support website 

http://www.scia-online.com/en/online-support.html 

Website 
Link to Tutorials  

http://www.Scia-online.com > Support & Downloads > Downloads > input e-mail address > Scia Engineer > Scia Engineer Manuals 

& Tutorials 

Link to eLearning 

 http://www.scia-online.com > Support & Downloads > eLearning 

Link to Demo version 

http://www.Scia-online.com > Support & Downloads > Secured Downloads > input username and password > Service Packs > Scia 

Engineer > Setup ï Scia Engineer 

mailto:support@scia.net
http://www.scia-online.com/en/online-support.html
http://www.scia-online.com/
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Introduction 
 

This tutorial describes the main functions of Scia Engineer 15, the input of design data and calculation of a 3D steel frame building.  

 

The tutorial will begin with the creation of a new project and the modelling of the steel frame structure. After the input of all frame geometry 
and loads, the structure will be calculated and the results will be viewed.  Next, the input of the slenderness and buckling parameters of 
the frame will be discussed, followed by the steel member calculations which contain the inclusion of unity checks and member 

optimization.  Next, a rigid steel connection will be modelled and displayed within the structure.  Lastly, the tutorial will discuss how to 
format an engineering report while properly displaying the calculation results. 

 

The figure below shows the computational model of the structure that will be completed through this tutorial (the units are in the Imperial 

system, e.g. kips, feet): 

 

 

 

  



 

 

Getting started 

Starting a project 

Starting the program 

Before you can start a project, you need to start the program first. 

 

1. Double-click on the Scia Engineer shortcut in the Windows Desktop. 

Or: 

2. If the shortcut is not installed, click [Start] and choose Programs > Scia Engineer 15> Scia Engineer 15. 

 

If the software cannot locate a license file, you will receive a dialogue box indicating that no license was found.  A second dialogue box 

will then list the restrictions of the demo version.  Click [OK] in both windows. 

 

For this Tutorial, you must start a new project. 

 

Starting a new project 

 

1. If the dialogue Open appears, click [Cancel]. 

2. Click the New icon  in the toolbar.  

 

 

 

In the Select New Project dialogue box, choose the Analysis environment by clicking on the corresponding icon. Confirm your choice 

by clicking [OK]. 

Now, the Project data dialogue box is opened.  Here, you can enter general data about the project. 
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3. In the Basic Data group, enter your preferred data.  The data you enter will be displayed on the output produced by Scia 

Engineer, e.g. in the document and on the drawings. 

 

4. Choose the Project level: Advanced and Model: One. 

5. Click on the rectangular button  below National Code to choose the default code for the project.  This code will 
determine the available materials, combination rules and code checks.  For the tutorial we will choose IBC (International 
Building Code). The window Codes in project is opened. 

 

- Click [Add]. 

- The dialogue box Available national codes are opened. 

- Select the USA flag and click [OK]. 

- You will return to the Codes in project dialogue and IBC is added. 

- Select the flag named IBC. 

- Select the Active code option and click [Close]. 

- You will return to the Project data window and IBC is the active code. 

 

6. Select Frame XYZ in the Structure field. 

The structure type (Frame XZ, Frame XYZ, Plate XY, General XYZ, etc.) will restrict the input possibilities during the 

calculation. 
 

7. In the Material group, select Steel.  Below the item Steel, a new item Material will appear. 

 

8. Choose A36 from the menu. 

 

9. Confirm your input with [OK]. 

 

10. On the Code Setup tab, you can see the specific codes that are used for the generation of loads and the design of steel, 

concrete and cold formed steel structures.  In addition to these codes, you can also choose the measurement system and 
formatting that will be used throughout the project.  



 

 

11. Click on Code Setup tab and click on the  button beside Code setup.  Now, the Format and measuring system 

dialogue box is opened. Choose Imperial format and click [OK]. 

 

 

 

 

 

Notes: 

On the Basic data tab, you can set a project level.  If you choose ñstandardò, the program will only show the most frequently used 

basic functions.  If you choose ñadvancedò, all basic functions will be shown.   

On the Functionality tab, you choose the options you need.  The non-selected functionalities will be filtered from the menus, thus 
simplifying the program and the analysis.  
On the Load tab, you will find the value for the acceleration of gravity and the applicable wind and snow loads that can be activated 

with the Climate loads functionality. 

. 
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Project management 
 

Save, Save as, Close and open 
 

Before entering the software to complete the frame construction, we will first discuss how to save a project, how to open an existing 

project and how to close a project. While completing the tutorial, the project can be saved at any time, that way you can leave the 

program at any time and resume the project from the save location later. 

 

Saving a project 

Click on   in the toolbar. 

 

If a project has not yet been saved, the dialog box Save as appears. Navigate to the location or the drive where you want to save your 

project in. Select the folder or subfolder in which you want to save the project and enter the project file name in File name field.  Once 

this is complete click on [Save] to save the project. 

If you press  twice, the project is automatically stored with the same name. If you choose File > Save as in the main menu, you 

can enter a new file name or save location for the project file.  

 

Closing a project 

 

To close a project, choose File > Close in the main menu. 

 

A dialog box appears asking if you want to save the project. Depending on your choice, the project is saved and the active dialog is 

closed. 

 

Opening a project 

Click on   to open an existing project. 

 

A list with Scia Engineer projects appears. Select the desired project and click [OK] (or double-click on the project to open it). 

  



 

 

Project Unit Setup 

Changing the units 
At the beginning of a new project, verify that the units used by Scia Engineer are compatible with your desired units. To check and 

modify the units: 

1. Click on Setup in the main menu and select Units. 

 

 
 

2. In the Units window you can view the units for different options and modify them to your desired unit system. 

 

 

 

Note: 
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It is possible to create a default template file that contains user preferences for desired units, scales and fonts.  A template file can be 

created and saved so that the user can load the desired template file before beginning a new project.  The creation and use of template 

files is not discussed in this tutorial.  

 

 



 

 

Geometry Input 
 

Input of the geometry 
When starting a new project, the specific geometry of the structure must be entered.  The structure can be entered directly, or it is 

possible to add geometry using instance templates with parametric blocks, DXF files, DWG files and other formats. 

Profiles 

When entering one or more 1D structural elements, a profile type is immediately assigned to each member.  By default, the act ive 
profile type is represented.  At any time it is possible to open the profile library to activate another profile type.  If you want to add a 

structural part before a profile type has been defined, the profile library will automatically be opened. 

 

Adding a profile 

3. Click on the Cross-Sections  icon in the toolbar. 
 

The Cross-Section manager is opened. If no profiles have been entered in the project, the New cross-section window will 
be automatically opened. 

 

                 

 

 

4. Click Profile library in the group Available groups. 

5. In the Available items of this group, you can choose a I-shaped profile   . Choose HP(lmp) 8X36 from the list. 

6. Click [Add] or  to add the profile to the project.  
 

 
7. Add W8X13 and W6X12 in a similar way. 

8. In the Available items for this group, you can choose an angle section   . Choose L(lmp) 3X3X1/4 from the list. 
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9. Click [Add] or  to add the profile to the project. 
 
 

10. Click [Close] in the New cross-section window, the Cross-Sections manager will appear. 
 
 

 
 

11. Click [Close] to close the Cross-Sections manager and to return to the project. 

Geometry 

Structure menu 

1. When a new project is started, the Structure menu is automatically opened in the Main window. If you want to modify the 
structure at a later time, you must double-click on Structure in the Main window. 
 



 

 

                                

 

 

2. In the Structure menu, you can choose different structural elements to enter the structure. 

 

To set up the structure, you must enter the first frame.  After doing so, the frame can be copied and the wind bracings and the horizontal 

beams will be entered. 

To enter the frame, you can simply add members such as columns and beams.  Scia Engineer however offers multiple Catalogue blocks, 

allowing for a smooth and simple input of the structure. 

Entering a frame using a Catalogue Block 

1. To enter a new frame, use the option Advanced input > Catalogue Blocks in the Structure menu. The Block select 
manager is opened. 

 

               

 

2. In the Available Groups group, choose a Frame 2D 

3. In the Available items of this group, you can choose the first frame   .  
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4. Confirm your choice with [OK]. The Geometry block window appears. 
 

               
 

5. Now, enter the frame dimensions: L = 39.5 ft, H1 = 16.5 ft and H2 = 3.5 ft 
 

6. In the pull-down menu, choose HP 8X36 for the Column and W8X13 for the Beam. 
 

7. Confirm your input with [OK]. The Catalogue block manager appears. 

 

         
 

 
 

8. Click [OK] to return to the project. 

 
9. The frame is positioned with the left column at the origin of the coordinate system.  To complete this, type the coordinates 0,0 

in the Command line and press <Enter> to confirm your input. 

 



 

 

                 

 

10. End the input with the <ESC> key. 

 

Notes: 

The properties of selected elements are shown and can be modified in the Properties window.  If no section has been defined in the 

project, the New cross-section window will automatically appear as soon as you try to enter a structural element (column, beam, 

brace, etc.).  At any time, you can end your active input by pressing either the <Esc> key either the right mouse button.   

 

To quickly visualize the entire structure, click Zoom All  in the toolbar. 

 

When entering coordinates using the command line, separate the desired coordinates using either a comma (,) or a space.  

 

After input of the first frame, it can be copied in order to obtain the structure for the entire hall.  Because the hall requires two additional 

steel frames, you can use the multiple copy option   to complete this task. 
 

 

 

 

 

Create multiple copies 

1. First select all entities to be copied.  Since it is necessary to copy all the beams and columns in the frame, you can use the 

Select All icon  . 
 

In this way, all beams and nodes are selected; this is represented in magenta: 
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2. Now, you can use the Multiple copy option  (Modify > Multiple copy). 

 

     
 

3. In the Number of copies field, enter 2. 
 

4. To manually set the distance between the frames, deactivate the Define distance by cursor option.  Now, you can enter the 
distance 20ft as the y distance vector. 
 

5. Click [OK] to confirm your input. The frame has now been copied. 
 

6. Press <ESC> to finish the selection 

 

                           

After the frames have been entered, the connecting beams of the frames can be entered.  The start and end nodes of the beams are 

already known, i.e. the start and end nodes of the entered beams or columns.  Therefore, you do not have to enter the beams by 
means of coordinates; instead you can use the Cursor snap settings. 

 



 

 

Cursor snap settings 

1. Double-click on the Cursor snap settings icon  in the Command line or click on the button  at the 
lower right of the screen. The Cursor snap settings window is opened: 

 

2. Activate the options a) and b) to pick the midpoints and the end points of members in this project. 

 
3. Click [OK] to confirm. 

 

           

 

Now, you can enter the beams that connect the individual frames. 

 

 

 

 

Entering a beam 

1. To enter a new beam, you use the Beam option in the Structure menu. 

 

2. In the Cross Section field, choose the third section, W6X12.  
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3. Since the structure type Frame XYZ has two horizontal directions (i.e. X and Y), you must indicate the right direction for the 

horizontal beam in the Direct field.  Choose the Axis Y option. 
 

4. Set the beam length to 20ft. 
 

5. The default insertion point is set to Begin so that the left point determines the insertion position of the beam. 

 
6. Confirm your input with [OK]. 

 

7. Now, you can enter the beam by clicking with your mouse on the top node of the left-hand side column of the first frame: 
 

      



 

 

8. Enter the other beams of the roof in a similar way, by always clicking on the top node of a column. 
 

 
9. Press <ESC> to finish the input. 

 
10. Press <ESC> once more to finish the selection. 

 

 

Note: 

The Multiple copy option also allows for the automatic input of the beams connecting the frames. 

 

In the location between the first and second frame, we will add two more horizontal beams. To enter these beams, you could use the 

Beam option.  Scia Engineer however allows the user to copy these entities manually. 

 

Copying entities 

1. First indicate the entity that is to be copied. Since the beam we want to add is a horizontal beam, you can select any of the 
entered beams with the left mouse button.  The magenta color indicates that the beam is selected.  The properties of the 

beam are shown in the Properties window. 
 

2. Click with the right mouse button somewhere in the working environment.  The menu that lists the available possibilities for 

the selected entity appears: 
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3. In this menu, choose the option  

 
4. The program asks for the Start point of the member being copied.  Click with the left mouse button on the start node of the 

selected beam. 
 

      
 

5. Now, you must enter the End point, i.e. the position where the starting point should be copied.  As the new beams start in 

the middle of the columns, the midpoint of one of the columns of the first frame is chosen. 
 



 

 

    
 

As the midpoints option was already activated for the Snap settings, you can simply pick the center point of the column. 

 

6. After the first beam is copied, the copy command remains active so that you can also pick the midpoint of the second column 

of the first frame in order to enter a horizontal beam at that position. 
 

7. Press <ESC> to finish the input. 

 
8. Press <ESC> once more to finish the selection 

 

After the input of the horizontal beams, you can enter the required bracings.  

The bracings are not columns or horizontal beams; therefore, you must use the Member command in the Structure menu. 

 

Entering bracings 

1. To enter a new member, use the Member option in the Structure menu. 
 

    
 

2. In the Type field, choose Wall Bracing (0). This member type is only considered for the STRUCTURAL model and does not 
influence the calculation model or the results. 

 
3. In the CrossSection field, choose the steel angle section, L3X3X1/4 
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4. Confirm your input by selecting [OK]. 

 
5. Now, the bracings can be entered between the second and third frame of the structure.  To accomplish this, make sure to 

always click on the start and end nodes of the columns that you want to connect the braces with: 

 

 
6. Press <ESC> to finish the input. 

 
7. Press <ESC> once more to finish the selection 

 

The structure has now been completely modelled.  It is now possible to finish the structure by entering additional geometry, i.e. 

haunches, hinges and supports. 

 

 



 

 

 

 

 

 

 

 

 

Haunches 

In this project, haunches are entered on the roof beams, at the connecting positions with the columns. In Scia Engineer a haunch is 
defined by the following parameters: 

 

- A section with variable height 

 

- A length, over which the variable height must vary up to 0 

 

Entering Haunches 

1. To enter a new haunch, use the 1D member components > Haunch option in the Structure menu. 
 

2. As indicated, a haunch requires a variable profile.  Since this project does not yet contain any variable profiles, the New 

cross-section window automatically appears. 
 

3. In the Available groups menu, select the Haunch group. 

 

                 

 

4. In Available items of this group, choose a I + I var -profile  

5. Click [Add] or  to add the profile to the project. The Cross-Section window then appears where the member properties 
attributed to the variable section can be modified. 
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6. In the I sections field, change the section to W8X13 by clicking the   button behind the section type. 
 

7. When the correct I-section is selected, the variable height va [inch] can then be set as 6 inches. 
 

8. Confirm your input with [OK]. 
 

9. The New cross-section window reappears; click [Close] to close this window. 

 
10. The Cross-Section manager appears; click [OK] to close this window as well. 

 

11. Now, the Haunch on beam window is opened. 
 

 
 

12. In the Position field, choose Begin to position the haunch at the start node of the member. 
 

13. In the Coord. definition field, choose the option Abso to indicate that the length, over which the variable height must vary, 
can be entered in absolute units, i.e. in feet. 
 

14. When the Coord. Definition is adapted; the length of the haunch can be entered in the Length x [ft] field.  For this project, 
enter length 3.5ft. 
 



 

 

15. Confirm your input with [OK] 
 

16. The program will now ask you to indicate the members, on which a haunch must be entered.  Select the 6 roof beams with 
the left mouse button: 
 

      
 
 

17. Press <ESC> to finish the input. 
 

18. Press <ESC> once more to finish the selection 

 

As the previous image already shows the haunches are located in the correct locations on all 6 roof beams.  However, depending on 

how you input the roof beams initially and which nodes you chose as the Start nodes the haunches may be incorrectly positioned on one 
side of the hall.  To visualize this situation, you need to click the following buttons in the command line: 

¶ Show/hide surfaces  to show the surfaces of the sections. 

¶ Render geometry  to obtain a rendered view of the members. 

 

The position of the three haunches that were input incorrectly can be corrected in the Properties window. 
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Adapting Entities through the Properties window 

1. Select the 3 haunches to be adapted with the left mouse button. 
 

 
 

2. The Properties window shows the common properties of these 3 entities 

 

 
 
 

3. Here, you can see that the Position is set to Begin, in accordance with your input. 
 

4. Change this Position to End 



 

 

 

 
 
The modification is immediately reflected in the graphical window. 
 

5. Press <ESC> to finish the selection. 

 

            

In the command line, click Show/hide surfaces  and Render geometry  to deactivate both options and visualise the system 
lines of the members again. 
 

Note: 

A haunch entered into the structure overwrites the original section that was chosen for a specific beam.  For this project, this specifically 

means that the profile of the roof beam is replaced by the I + I var profile. If the haunch is removed, the I + I var profile will be maintained 
instead of the I-section of the roof profile. 

 






































































































